
Oracle Install Base

Implementation Guide  

Release 11i  

September 2002

Part No. B10167-02



Oracle Install Base Implementation Guide, Release 11i  

Part No. B10167-02

Copyright © 2001, 2002, Oracle Corporation. All rights reserved. 

The Programs (which include both the software and documentation) contain proprietary information of 
Oracle Corporation; they are provided under a license agreement containing restrictions on use and 
disclosure and are also protected by copyright, patent and other intellectual and industrial property 
laws. Reverse engineering, disassembly or decompilation of the Programs, except to the extent required 
to obtain interoperability with other independently created software or as specified by law, is prohibited.

The information contained in this document is subject to change without notice. If you find any problems 
in the documentation, please report them to us in writing. Oracle Corporation does not warrant that this 
document is error-free. Except as may be expressly permitted in your license agreement for these 
Programs, no part of these Programs may be reproduced or transmitted in any form or by any means, 
electronic or mechanical, for any purpose, without the express written permission of Oracle Corporation.

If the Programs are delivered to the U.S. Government or anyone licensing or using the programs on 
behalf of the U.S. Government, the following notice is applicable:

Restricted Rights Notice  Programs delivered subject to the DOD FAR Supplement are "commercial 
computer software" and use, duplication, and disclosure of the Programs, including documentation, 
shall be subject to the licensing restrictions set forth in the applicable Oracle license agreement. 
Otherwise, Programs delivered subject to the Federal Acquisition Regulations are "restricted computer 
software" and use, duplication, and disclosure of the Programs shall be subject to the restrictions in FAR 
52.227-19, Commercial Computer Software - Restricted Rights (June, 1987). Oracle Corporation, 500 
Oracle Parkway, Redwood City, CA 94065.

The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently 
dangerous applications. It shall be the licensee's responsibility to take all appropriate fail-safe, backup, 
redundancy, and other measures to ensure the safe use of such applications if the Programs are used for 
such purposes, and Oracle Corporation disclaims liability for any damages caused by such use of the 
Programs. 

Oracle is a registered trademark, and Oracle8, Oracle8i, OracleMetaLink, and SQL*Plus are trademarks or 
registered trademarks of Oracle Corporation. Other names may be trademarks of their respective 
owners. 



Contents

Send Us Your Comments ..................................................................................................................    vii

Preface............................................................................................................................................................    ix

1 Overview of Oracle Install Base

1.1 Summary of Oracle Install Base ..........................................................................................    1-1
1.2 Features of Oracle Install Base.............................................................................................    1-2
1.2.1 Functional Overview .....................................................................................................    1-2
1.2.2 Instance Maintenance ....................................................................................................    1-2
1.2.3 Multiple Party/Account Relationships ......................................................................    1-2
1.2.4 Accounting Classification .............................................................................................    1-3
1.2.5 Multiple Inter-Instance Relationships.........................................................................    1-3
1.2.6 History of All Transactions...........................................................................................    1-3
1.2.7 Mass-Edit and Future-Dated Transactions.................................................................    1-3
1.2.8 Extended Attributes.......................................................................................................    1-3
1.3 Integration Points and Dependencies for Oracle Install Base.........................................    1-3
1.3.1 Cross-CRM Integration .................................................................................................    1-3
1.3.2 ERP-Install Base Integration .........................................................................................    1-4
1.3.3 Inventory Receipt and Purchase Order Receipt ........................................................    1-4
1.3.4 Inventory Transactions..................................................................................................    1-5
1.3.5 Order Management Integration ...................................................................................    1-6
1.3.6 WIP Integration ............................................................................................................    1-10
1.3.7 Asset Integration ..........................................................................................................    1-11
1.3.8 Project Integration........................................................................................................    1-11
 iii



1.3.9 Use of Transactions Details.........................................................................................    1-11

2  Implementation and Setup for New Users

2.1 Product Dependencies and Requirements.........................................................................    2-1
2.2 Setup Checklist for New Users............................................................................................    2-2
2.3 Related Setup Steps within Other Oracle Applications...................................................    2-5
2.3.1 Synchronize On-Hand Balance between Inventory and Install Base .....................    2-5
2.3.2 Set Up Inventory Serial Control at the Master Level ................................................    2-5
2.3.3 Set Up Install Base Items in the Item Master..............................................................    2-5
2.3.4 Set Up Parties ..................................................................................................................    2-6
2.3.5 Set Up Vendors ...............................................................................................................    2-6
2.3.6 Set Up Employees...........................................................................................................    2-6
2.3.7 Set Up Party Accounts ...................................................................................................    2-6
2.3.8 Set Up Party Contacts ....................................................................................................    2-6
2.3.9 Confirm the Setup of the Oracle Service Fulfillment Manager Event Queue .......    2-7
2.3.10 Set Up the Action Menu in Order Management........................................................    2-8
2.3.11 Set Up the Order Management Workflow .................................................................    2-9
2.4 Related Setup Steps within Oracle Enterprise Install Base............................................    2-12
2.4.1 Run the License Manager Program ...........................................................................    2-12
2.4.2 Verify the Setup of Four Profile Options for Enterprise Install Base....................    2-12
2.4.3 Verify Location IDs in HZ_LOCATIONS.................................................................    2-12
2.4.4 Verify Codes for Asset Update Statuses ...................................................................    2-13
2.5 Setup Steps within Oracle Install Base .............................................................................    2-13
2.5.1 Set Up Installation Parameters ...................................................................................    2-14
2.5.2 Set Up Codes for Party-Account and Party-Contact Relationship Types............    2-16
2.5.3 Verify Codes for Instance Relationship Types.........................................................    2-17
2.5.4 Verify Extended Attribute-Level Codes ...................................................................    2-19
2.5.5 Set Up Extended Attribute Pools ...............................................................................    2-20
2.5.6 Set Up Extended Attribute Classifications ...............................................................    2-21
2.5.7 Set Up Extended Attributes ........................................................................................    2-22
2.5.8 Verify Accounting Classification Codes ...................................................................    2-23
2.5.9 Set Up Instance Type Codes .......................................................................................    2-24
2.5.10 Verify Codes for Instance Location Sources.............................................................    2-25
2.5.11 Verify Party Sources.....................................................................................................    2-27
2.5.12 Set Up Codes for Instance-Organization Unit Relationship Types ......................    2-28
iv



2.5.13 Set Up Version Labels..................................................................................................    2-29
2.5.14 Set Up System Type Codes .........................................................................................    2-31
2.5.15 Set Up Split Process Reasons......................................................................................    2-31
2.5.16 Set Up Instance Statuses..............................................................................................    2-32
2.5.17 Set Up Source Transaction Types ..............................................................................    2-34
2.5.18 Set Up Transaction Subtypes......................................................................................    2-35
2.5.19 Set Up the Transaction Subtypes LOV from non-Service Processes ....................    2-38
2.5.20 Verify Transaction Status Codes................................................................................    2-39
2.5.21 Verify Transaction Error Source Types.....................................................................    2-40
2.5.22 Create Business Users..................................................................................................    2-41
2.5.23 Create Agent Users ......................................................................................................    2-48
2.5.24 Schedule the Expire End Dated Instances Program................................................    2-49
2.5.25 Schedule the Initiate Mass Edit Program .................................................................    2-50
2.5.26 Schedule the Process Mass Edit Program.................................................................    2-51
2.5.27 Schedule the Process Old Order Lines-Fulfillable Only Program ........................    2-51
2.5.28 Schedule the Resubmit Interface Process .................................................................    2-52
2.5.29 Schedule the Resubmit Waiting Transactions Program.........................................    2-53
2.5.30 Final Synchronize On-Hand Balance between Inventory and Install Base .........    2-53

3  Implementation and Setup for Upgrade Users

3.1 Product Dependencies and Requirements ........................................................................    3-1
3.2 Setup Checklist for Upgrade Users.....................................................................................    3-2

4 Oracle Install Base System Profile Options and Debug Information

4.1 Oracle Install Base System Profile Options .......................................................................    4-1
4.2 Setting the Debug Option.....................................................................................................    4-3
v



vi



Send Us Your Comments

Oracle Install Base Implementation Guide, Release 11i  

Part No. B10167-02

Oracle Corporation welcomes your comments and suggestions on the quality and usefulness of this 
document. Your input is an important part of the information used for revision.

■ Did you find any errors?
■ Is the information clearly presented?
■ Do you need more information? If so, where?
■ Are the examples correct? Do you need more examples?
■ What features did you like most?

If you find any errors or have any other suggestions for improvement, please indicate the document 
title and part number, and the chapter, section, and page number (if available). You can send com-
ments to us by e-mail:

mfgdoccomments_us@oracle.com

If you would like a reply, please give your name, address, telephone number, and (optionally) elec-
tronic mail address.

 If you have problems with the software, please contact your local Oracle Support Services.
vii



viii



Preface

Audience for This Guide
Welcome to Release 11i of the Oracle Install Base Implementation Guide.

This guide assumes you have a working knowledge of the following:

■ The principles and customary practices of your business area.

If you have never used Oracle Install Base, Oracle suggests you attend one or 
more of the Oracle Install Base training classes available through Oracle 
University.

■ The Oracle Applications graphical user interface. 

To learn more about the Oracle Applications graphical user interface, read the 
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications 
product information.

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle Corporation is actively engaged with other 
market-leading technology vendors to address technical obstacles so that our 
documentation can be accessible to all of our customers. For additional information, 
ix



visit the Oracle Accessibility Program Web site at 
http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation JAWS, a Windows screen 
reader, may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, JAWS may not always read a line of text that 
consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation This 
documentation may contain links to Web sites of other companies or organizations 
that Oracle Corporation does not own or control. Oracle Corporation neither 
evaluates nor makes any representations regarding the accessibility of these Web 
sites. 

How To Use This Guide
This document contains the information you need to implement Oracle Install Base.

■ Chapter 1 provides overviews of the application, its features, functions, and 
integration points with other applications.

■ Chapter 2 provides details of the setup steps for new users to implement the 
product.

■ Chapter 3 provides details of the setup steps for upgrade users to implement 
the product.

■ Chapter 4 describes the configuration of the system profile options for the 
product.

Other Information Sources
You can choose from many sources of information, including online documentation, 
training, and support services, to increase your knowledge and understanding of 
Oracle Install Base.

If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF). Online 
help patches are available on MetaLink.
x



Related Documentation
Oracle Install Base shares business and setup information with other Oracle 
Applications products. Therefore, you may want to refer to other product 
documentation when you set up and use Oracle Install Base.

You can read the documents online by choosing Library from the expandable menu 
on your HTML help window, by reading from the Oracle Applications Document 
Library CD included in your media pack, or by using a Web browser with a URL 
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at 
http://oraclestore.oracle.com.

Documents Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI) available with this release of Oracle Install Base (and 
any other Oracle Applications products). This guide also includes information on 
setting user profiles, as well as running and reviewing reports and concurrent 
processes.

You can access this user’s guide online by choosing "Getting Started with Oracle 
Applications" from any Oracle Applications help file.

Documents Related to This Product

Oracle Enterprise Install Base Implementation Guide
Refer to this guide to understand the implementation of a closely related product.

Installation and System Administration

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
also introduces the concepts behind Applications-wide features such as Business 
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.
xi



Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is handled 
using Oracle Rapid Install, which minimizes the time to install Oracle Applications, 
the Oracle8 technology stack, and the Oracle8i Server technology stack by 
automating many of the required steps. This guide contains instructions for using 
Oracle Rapid Install and lists the tasks you need to perform to finish your 
installation. You should use this guide in conjunction with individual product 
user’s guides and implementation guides.

Oracle Applications Supplemental CRM Installation Steps
This guide contains specific steps needed to complete installation of a few of the 
CRM products. The steps should be done immediately following the tasks given in 
the Installing Oracle Applications guide.

Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or 
Release 11.0 products to Release 11i. This guide describes the upgrade process and 
lists database and product-specific upgrade tasks. You must be either at Release 10.7 
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i. 
You cannot upgrade to Release 11i directly from releases prior to 10.7.

Maintaining Oracle Applications
Use this guide to help you run the various AD utilities, such as AutoUpgrade, 
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and 
others. It contains how-to steps, screenshots, and other information that you need to 
run the AD utilities. This guide also provides information on maintaining the 
Oracle applications file system and database.

Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide
This guide explains how to define periodic and event alerts to monitor the status of 
your Oracle Applications data.
xii



Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications 
development staff. It describes the Oracle Application Object Library components 
needed to implement the Oracle Applications user interface described in the Oracle 
Applications User Interface Standards for Forms-Based Products. It also provides 
information to help you build your custom Oracle Forms Developer 6i forms so that 
they integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle 
Applications development staff. It describes the UI for the Oracle Applications 
products and how to apply this UI to the design of an application built by using 
Oracle Forms.

Other Implementation Documentation

Multiple Reporting Currencies in Oracle Applications
If you use the Multiple Reporting Currencies feature to record transactions in more 
than one currency, use this manual before implementing Oracle Install Base. This 
manual details additional steps and setup considerations for implementing Oracle 
Install Base with this feature.

Multiple Organizations in Oracle Applications
This guide describes how to set up and use Oracle Install Base with Oracle 
Applications’ Multiple Organization support feature, so you can define and support 
different organization structures when running a single installation of Oracle Install 
Base.

Oracle Workflow Guide
This guide explains how to define new workflow business processes as well as 
customize existing Oracle Applications-embedded workflow processes.You also use 
this guide to complete the setup steps necessary for any Oracle Applications 
product that includes workflow-enabled processes.

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup and reference information for the 
Oracle Install Base implementation team, as well as for users responsible for the 
ongoing maintenance of Oracle Applications product data. This manual also 
provides information on creating custom reports on flexfields data.
xiii



Oracle eTechnical Reference Manuals
Each eTechnical Reference Manual (eTRM) contains database diagrams and a 
detailed description of database tables, forms, reports, and programs for a specific 
Oracle Applications product. This information helps you convert data from your 
existing applications, integrate Oracle Applications data with non-Oracle 
applications, and write custom reports for Oracle Applications products. Oracle 
eTRM is available on Metalink

Oracle Manufacturing APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes APIs and open interfaces found in Oracle Manufacturing.

Oracle Order Management Suite APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes APIs and open interfaces found in Oracle Order Management Suite.

Oracle Applications Message Reference Manual
This manual describes Oracle Applications messages. This manual is available in 
HTML format on the documentation CD-ROM for Release 11i.

Oracle CRM Application Foundation Implementation Guide
Many CRM products use components from CRM Application Foundation. Use this 
guide to correctly implement CRM Application Foundation.

Oracle Enterprise Install Base Implementation Guide 
This guide is required for the setup of the ERP integrations with Install Base.

Oracle Manufacturing Implementation Guide 
This document is required for the setup of Inventory, Bills of Material, and WIP.

Oracle Service Fulfillment Manager Implementation Guide 
This document is required for the setup of the SFM (Service Fulfillment Manager) 
Event Queue used in the ERP integration with Install Base.
xiv



Training and Support

Training
Oracle offers training courses to help you and your staff master Oracle Install Base 
and reach full productivity quickly. You have a choice of educational environments. 
You can attend courses offered by Oracle University at any one of our many 
Education Centers, you can arrange for our trainers to teach at your facility, or you 
can use Oracle Learning Network (OLN), Oracle University’s online education 
utility. In addition, Oracle training professionals can tailor standard courses or 
develop custom courses to meet your needs. For example, you may want to use 
your organization’s structure, terminology, and data as examples in a customized 
training session delivered at your own facility.

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle Install Base working for 
you. This team includes your Technical Representative, Account Manager, and 
Oracle’s large staff of consultants and support specialists with expertise in your 
business area, managing an Oracle8i server, and your hardware and software 
environment.

OracleMetaLink
OracleMetaLink is your self-service support connection with web, telephone menu, 
and e-mail alternatives. Oracle supplies these technologies for your convenience, 
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain 
information and advice from technical libraries and forums, download patches, 
download the latest documentation, look at bug details, and create or update TARs. 
To use MetaLink, register at (http://metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or 
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows: 
Technical Libraries/ERP Applications/Applications Installation and 
Upgrade/Alerts.

Self-Service Toolkit: You may also find information by navigating to the 
Self-Service Toolkit page as follows: Technical Libraries/ERP 
Applications/Applications Installation and Upgrade.
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Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

About Oracle
Oracle Corporation develops and markets an integrated line of software products 
for database management, applications development, decision support, and office 
automation, as well as Oracle Applications, an integrated suite of more than 160 
software modules for financial management, supply chain management, 
manufacturing, project systems, human resources and customer relationship 
management.

Oracle products are available for mainframes, minicomputers, personal computers, 
network computers and personal digital assistants, allowing organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.

Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.
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Overview of Oracle Install
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Overview of Oracle Install Base

This chapter covers the following topics:

■ Summary of Oracle Install Base

■ Features of Oracle Install Base

■ Integration Points and Dependencies for Oracle Install Base

1.1 Summary of Oracle Install Base
Oracle Install Base is a repository of product information, location, status, party 
relationships, configuration, ownership, accounts, and change history for a 
customer product, an asset, or a software license. It offers life-cycle tracking of an 
item from the time that it is received, in inventory, in WIP, in projects, at customer 
sites, or during repair. Install Base also records a history of changes to tracked items 
and does so independently of their ownership, physical location, or accounting 
classification.

Install Base is specifically designed to track serialized and non-serialized item 
instances for the following:

■ Tangible products

■ Tangible assets

■ Software

■ Communications and utility services
 Base 1-1



Features of Oracle Install Base
1.2 Features of Oracle Install Base

1.2.1 Functional Overview
Oracle Install Base leverages existing CRM and ERP applications and is fully 
integrated with the Oracle e-Business Suite. It provides the following functionality:

■ Instance maintenance 

■ Instance to multiple party/account relationships

■ Accounting classifications

■ Maintenance of instance-to-instance relationships

■ History of all changes

■ Mass edits by a future date

■ Definable extended attributes

1.2.2 Instance Maintenance 
Oracle Install Base provides for creation, update, querying, and copying of instances 
through Install Base user interfaces or through integration from other modules, 
such as Field Service, Teleservice, Service Contracts, Depot Repair, Receipts, Work 
in Process (WIP) completion, Inventory transactions, Fixed Assets, Projects, Order 
Management, and Shipping. It provides tracking of location, status, addresses, 
contacts, business party relationships, inter-instance relationships, an extended set 
of attributes for pricing, and the instance itself. 

1.2.3 Multiple Party/Account Relationships
Oracle Install Base provides for association of an instance to different party types 
such as party, employee, or vendor. Each Install Base instance must always have an 
owner. If the owner is of type Party, then an account of the party is also mandatory. 
For each party type, you can define relationship types, such as Service Provider. 
Each party can have multiple accounts. This feature supports the multiple business 
relationships for globalization and outsourcing requirements of today’s businesses. 
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Integration Points and Dependencies for Oracle Install Base
1.2.4 Accounting Classification
Oracle Install Base provides for associations of an instance with different account 
types, such as inventory, customer product, and asset, to support the tracking of 
internally and externally owned products.

1.2.5 Multiple Inter-Instance Relationships
Oracle Install Base provides for different kinds of relationships that can exist 
between instances, such as component-of, member-of, connected-to, provided-by, 
upgraded-from, and installed-on. It also supports the creation of a component-of 
structure at the time of instance creation from Bills of Material (BOM) during 
integration with Order Management (OM).

1.2.6 History of All Transactions
Oracle Install Base records any changes made to an instance in terms of the 
transaction type, the source reference, date, and time. It tracks changes to the 
inter-instance relationships, party/account relationships, location, resources, 
version labels, and associated operating units, to name a few. Given a time stamp, 
all changes are viewable in Install Base.

1.2.7 Mass-Edit and Future-Dated Transactions 
Oracle Install Base supports a mass edit function so that a set of instance attributes 
such as location and party change can be updated given a specific set of selection 
criteria. These transactions can be set to run on a future date.

1.2.8 Extended Attributes
Oracle Install Base supports user-definable extended attributes by item, item 
category, instance, and enterprise. These attributes are created at instance creation 
and can be updated.

1.3 Integration Points and Dependencies for Oracle Install Base

1.3.1 Cross-CRM Integration
Oracle Install Base has the following integration points within the CRM suite:

■ Updates to Counters and Notes
Overview of Oracle Install Base 1-3



Integration Points and Dependencies for Oracle Install Base
■ Direct updates from Field Service and Advanced Service Online

■ Access for view and reference by applications such as Service Contracts, 
Teleservice, and Depot Repair.

■ Trading Community Architecture (TCA) party for party and relationship

When using the TCA merge routines with Install Base records, Oracle 
recommends that the party merge be done before the account merge. In 
addition, the internal party that is set up in the Install Base parameter cannot be 
used in the merge. For details, refer to Section 2.5.1 in this document.

■ Integration with Oracle Quoting through transaction detail 

When entering a quote, you can invoke the transaction detail to enter additional 
information for Install Base. When the quote becomes an order, the transaction 
detail is copied against an Order Management order. This is processed when the 
order is shipped as described in the Order Management integration. 

1.3.2 ERP-Install Base Integration
Oracle Install Base has the following integration points with Oracle ERP 
applications through the Oracle Service Fulfillment Manager (SFM) Event Queue 
and Oracle Enterprise Install Base processing:

■ Inventory receiving and purchase order receiving

■ Inventory transactions

■ Order management

■ RMA receiving

■ Sales order shipping

■ Sales order fulfillment

■ Fixed assets

■ Projects

■ Work in process

1.3.3 Inventory Receipt and Purchase Order Receipt
If an item is set up as trackable in Install Base, then an inventory receipt such as 
miscellaneous receipt or PO receipt causes the creation or update of an Install Base 
instance. At the time the inventory transaction happens, a message is sent to the 
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Integration Points and Dependencies for Oracle Install Base
SFM Event Queue. It is automatically dequeued and processed to update Install 
Base. Refer to Oracle Enterprise Install Base Implementation Guide and Oracle Enterprise 
Install Base Concepts and Procedures for more information.

If an item is non-serialized and controlled, and if an instance already exists for it at 
the same subinventory location, then it is added to the quantity of the instance with 
the same subinventory location. If an instance for the same item subinventory 
location does not exist, then a new instance is created.

If an item is serial controlled at receipt or is predefined, then an instance is created 
for it with quantity of 1 with location in the subinventory location.

If an item is serial controlled at order issue, then it is treated as a non-serialized 
controlled item in inventory. Only at order-issue time, when it gets a serial number, 
is an instance with the serial number created.

1.3.4 Inventory Transactions
If an Install Base trackable item has been received into inventory and an Install Base 
instance has been created, then any subsequent inventory transactions will be 
tracked in Install Base as well.

For an inventory transfer or move order transaction, the location of an instance is 
updated to reflect the new location for a serialized item. For a non-serialized item, 
the quantity of the instance at the From location is subtracted, and the quantity of 
the instance at the To location is increased by the quantity being moved. If the item 
is issued to a WIP job, then the location of the item reflects the WIP job number. If it 
is issued to an asset, then it reflects the asset number. If it is issued to a project/task, 
then the location of the instance shows the project and task number. Refer to 
Enterprise Install Base documentation for more details.

The supported Inventory transactions are as follows: 

■ Subinventory transfer

■ Inter-organization transfer

■ Cycle count adjustment

■ Physical inventory adjustment

■ Intransit receipt

■ Intransit shipment

■ Purchase order receipt

■ Account alias issue and receipt
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■ Account issue and receipt

■ Miscellaneous issue and receipt

■ Sales order issue

■ Sales order pick

■ RMA receipt

The work-in-process inventory sourced transactions are described in Section 1.3.6, 
"WIP Integration".

1.3.5 Order Management Integration
Order Management is the only ERP integration that implements the functionality of 
Install Base installation detail. This includes RMA receipt, sales order shipment, and 
sales order fulfillment. Figure 1–1 illustrates some of the relationships discussed in 
this section. Internal sales orders are not supported.
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Figure 1–1 Integration of Order Management with Install Base

1.3.5.1 RMA Receipt 
An RMA return receipt generates an inventory receipt material transaction in the 
Inventory application. If an item never existed in Install Base, then the RMA receipt 
causes a new instance to be created with the location in inventory. If the instance 
already exists in Install Base, then this return can cause a change of location to 
Inventory and other changes such as status and owner as specified in the 
transaction type setup used to process the transaction.

In the sales return line, installation detail can be invoked to specify additional 
details for this instance and other related instances for this update to Install Base. 

An RMA without receipt for shippable and non-shippable items is not supported in 
this release.
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Refer to Section 1.3.9 for information on the use of transaction detail. To use 
transaction detail, the transaction types being used have to be previously set up. 
Refer to Section 2.5.18 for instructions on setting up transaction types.

1.3.5.2 Sales Order Shipment
For an Install Base trackable, shippable item, a shipping transaction generates an 
inventory issue transaction in the Inventory application. 

For a serialized item already in inventory, this transaction causes a change of 
location and ownership, depending on the transaction type being used. When an 
item is being shipped for the first time and if it has Install Base trackable BOM 
components, then at the time of shipment, the component instances and 
component-of relationships for the trackable components are built in Install Base. 
The following rules apply:

■ A top assembly item must be serialized controlled. 

■ A top assembly must be of quantity 1.

■ Components can be non-serialized controlled.

■ A non-serialized parent cannot own serialized components. 

■ A component tree stops at a quantity greater than 1.

For items serialized at sales order issue, the first-time shipment transaction causes 
the creation of a new instance with the serial number. If it has trackable 
components, then the component instances and component-of configuration for 
these components are built as well. The same rules apply.

In this release the creation of configuration is not supported for non-serialized top 
assembly through OM Integration, except for pick-to-order (PTO) and 
assemble-to-order (ATO) models. This creation of configuration for non-serialized 
top assembly can be done through the Install Base user interface.

For a non-serialized controlled item, the quantity is subtracted from the instance 
with the inventory location, and a new instance is created with the customer 
ownership and location.

The creation of a PTO model is supported as in previous versions of Install Base. At 
the time of sales order line processing, Configurator enables the selection of 
optional items to be put into the PTO model. As a result, additional sales order lines 
are created for the mandatory and optional items. If they are Install Base trackable, 
then at the time of sales order shipment, instances of the top model, the trackable 
components, and the component-of relationships are created in Install Base. The 
PTO model need not be serialized controlled. 
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In all cases, at the sales order line for a sales order, installation detail can be invoked 
to specify additional details for this instance and other related instances, for this 
update to Install Base. Refer to Section 1.3.9 for information on the use of 
installation detail. 

To use the installation detail, the transaction types being used have to be previously 
set up. Refer to Section 2.5.18 for instructions on setting up transaction types.

In 11.5.6, the creation of an ATO is supported as well. At the time of sales order line 
processing, Configurator enables the selection of optional items to be put into the 
ATO model. Then a WIP job can be created for the configured item to be built in 
WIP. At the time of WIP assembly completion, the configured item instance and its 
configuration are created with the location in inventory. When it is shipped, the 
location and ownership will be changed to that of the customer. The ATO model 
need not be serialized controlled.

1.3.5.3 Sales Order Fulfillment
For the sales order line for an Install Base trackable, non-shippable item, the 
fulfillment activity in Order Management invokes the Install Base interface through 
the Order Line generic workflow, which is the same workflow that is used by the 
Sales For Communications (XNC) application.

For an Install Base trackable, non-shippable item, the serial control can be set at the 
level of sales order issue. The serial number for Install Base instances can be entered 
in the Installation detail before it is booked. The fulfillment transaction causes the 
creation of a new instance with the serial number. If it has trackable components, 
then the component instances and component-of configuration for these 
components will also be built the first time it is fulfilled. The following rules apply.

■ A top assembly item must be serialized controlled. 

■ A top assembly must be of quantity 1.

■ Components can be non-serialized controlled.

■ A non-serialized parent cannot own serialized component. 

■ A component tree stops at quantity greater than 1.

For a non-serialized controlled item, a new instance is created with the customer 
ownership and location.

In all cases, at the sales order line for a sales order, transaction detail can be invoked 
to specify additional details for this instance and other related instances for this 
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update to Install Base. Refer to Section 1.3.9 for information on the use of 
transaction detail. 

To use the transaction detail, the transaction types being used must have been 
previously set up. Refer to Section 2.5.18 for instructions on setting up transaction 
types.

1.3.6 WIP Integration
The creation of a serialized top assembly instance with components configuration is 
supported for WIP jobs with quantity of one. For jobs with more than one top 
assembly, the components used are distributed equally for all the top assemblies. 
No fractional quantity is supported.

For example, if four components are issued to one top assembly in a WIP job with a 
quantity of two, then at the end, two components will be assigned to one assembly 
and two will be assigned to the other. This is true even if you issue all four 
components to only one top assembly. Creation of a non-serialized top assembly 
instance with component configuration is not supported, with the exception of an 
ATO item.

At the time of the WIP assembly complete inventory receipt, the interface generates 
an inventory receipt in Inventory. The integration point with WIP is strictly through 
the Inventory material transaction, not through any internal WIP transactions. The 
Install Base interface creates an instance for the serialized top assembly and the 
component-of configuration of any Install Base trackable items issued to the WIP 
job. In this case, the serial numbers of the components are known at the time of 
creation. Only the components issued and returned before the assembly completion 
transaction are taken into consideration in the configuration buildup. Components 
issued and returned after the WIP assembly completion are ignored.

Only one level of configuration will be built for one WIP job. To process multiple 
levels of configuration, multiple jobs must be created and executed for 
sub-assemblies.

At the time of sales order shipment, the ownership and location are changed to that 
of the customer, depending on the transaction being used. The supported WIP 
material transactions are as follows:

■ WIP component issue: A component will be set up in Install Base as a child in a 
component-of configuration for the top assembly at job completion

■ WIP component return: A component will not be set up in Install Base as a child 
in a component-of configuration at job completion
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■ WIP negative (WIP -ve) component issue: A component will not be set up in 
Install Base as a child in a component-of configuration at job completion

■ WIP-ve component return: A component will be set up in Install Base as a child 
in a component-of configuration for the top assembly at job completion

■ WIP Assembly Completion: An assembly will be set up in Install Base as a 
parent in a component-of configuration with a location in inventory at job 
completion

■ WIP Assembly Return: The location of an assembly instance will be changed 
from Inventory to that of a WIP job

1.3.7 Asset Integration
For information about asset integration, refer to Oracle Enterprise Install Base 
Implementation Guide and Oracle Enterprise Install Base Concepts and Procedures.

1.3.8 Project Integration
For information about project integration, refer to Oracle Enterprise Install Base 
Implementation Guide and Oracle Enterprise Install Base Concepts and Procedures.

1.3.9 Use of Transactions Details
The Transaction Details window is used to capture additional information that is 
used to update the instance, an RMA return line, and a sales order line.

The Transaction Details can be activated on the sales order line window by clicking 
Actions and selecting Installation Details. For a full description of this window, refer 
to "Using the Transaction Details Window" in Oracle Install Base Concepts and 
Procedures and online help.
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Implementation and Setup for New Users

This chapter provides implementation and setup information for new users of 
Oracle Install Base. Refer to Chapter 3 if you have an earlier version of this 
application and are upgrading to this version.

This chapter covers the following topics:

■ Product Dependencies and Requirements

■ Setup Checklist for New Users

■ Related Setup Steps within Other Oracle Applications

■ Related Setup Steps within Oracle Enterprise Install Base

■ Setup Steps within Oracle Install Base

2.1 Product Dependencies and Requirements
The following modules must be installed and set up for Install Base to work. Refer 
to the appropriate guides to install and set up these modules:

■ Oracle Inventory

■ Oracle Enterprise Install Base

■ Oracle Service Fulfillment Manager

■ Oracle Order Management

■ Oracle Purchasing (Optional)

■ Oracle Accounts Receivable

■ Oracle Work in Process (Optional)

■ Oracle Bills of Material
Users 2-1
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2.2 Setup Checklist for New Users
This following table provides a checklist of setup steps for new users of Oracle 
Install Base. 

.

Table 2–1 Setup Checklist for New Users of Oracle Install Base

Step
Number Title

Required or
Optional Seeded? Extensible?

Section
Reference

1. Synchronize On-Hand 
Balance between Inventory 
and Install Base

Required NA NA Section 2.3.1

2. Set Up Inventory Serial 
Control at the Master 
Level

Required NA NA Section 2.3.2

3. Set Up Parties Required N N Section 2.3.4

4. Set Up Vendors Optional N N Section 2.3.5

5. Set Up Employees Optional N N Section 2.3.6

6. Set Up Party Accounts Required N N Section 2.3.7

7. Set Up Party Contacts Required N N Section 2.3.8

8. Confirm the Setup of 
Oracle Service Fulfillment 
Manager Event Queue

Required N N Section 2.3.9

9. Set Up the Action Menu in 
Order Management

Required N N Section 2.3.10

10. Set Up the Order 
Management Workflow

Required N N Section 2.3.11

11. Run the License Manager 
Program

Required N N Section 2.4.1

12. Verify the Setup of Four 
Profile Options for 
Enterprise Install Base

Required N N Section 2.4.2

13. Verify Location IDs in HZ_
LOCATIONS

Required Y N Section 2.4.3

14. Verify Codes for Asset 
Update Statuses

Optional Y N Section 2.4.4
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15. Set Up Installation 
Parameters

Required N N Section 2.5.1

16. Set Up Codes for 
Party-Account and 
Party-Contact Relationship 
Types

Required Y Y Section 2.5.2

17. Verify Codes for Instance 
Relationship Types

Required Y N Section 2.5.3

18. Verify Extended 
Attribute-Level Codes

Required Y N Section 2.5.4

19. Set Up Extended Attribute 
Pools

Optional N Y Section 2.5.5

20. Set Up Extended Attribute 
Classifications

Optional N Y Section 2.5.6

21. Set Up Extended 
Attributes

Optional N Y Section 2.5.7

22. Verify Accounting 
Classification Codes

Required Y N Section 2.5.8

23. Set Up Instance Type 
Codes

Optional N Y Section 2.5.9

24. Verify Codes for Instance 
Location Sources

Required Y N Section 2.5.10

25. Verify Party Sources Required Y N Section 2.5.11

26. Set Up Codes for 
Instance-Organization 
Unit Relationship Types

Required Y Y Section 2.5.12

27. Set Up Version Labels Optional Y Y Section 2.5.13

28. Set Up System Type Codes Required N Y Section 2.5.14

29. Set Up Split Process 
Reasons

Optional N Y Section 2.5.15

30. Set Up Instance Statuses Required Y Y Section 2.5.16

31. Set Up Source Transaction 
Types

Required Y Y Section 2.5.17

Table 2–1 Setup Checklist for New Users of Oracle Install Base

Step
Number Title

Required or
Optional Seeded? Extensible?

Section
Reference
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32. Set Up Transaction 
Subtypes

Required Y Y Section 2.5.18

33. Set Up the Transaction 
Subtypes LOV from 
non-Service Processes

Required Y N Section 2.5.19

34. Verify Transaction Status 
Codes

Required Y N Section 2.5.20

35. Verify Transaction Error 
Source Types

Required Y N Section 2.5.21

36. Create Business Users Required N N Section 2.5.22

37. Create Agent Users Required N N Section 2.5.23

38. Schedule the Expire End 
Dated Instances Program

Required N N Section 2.5.24

39. Schedule the Initiate Mass 
Edit Program

Required N N Section 2.5.25

40. Schedule the Process Mass 
Edit Program

Required N N Section 2.5.26

41. Schedule the Process Old 
Order Lines-Fulfillable 
Only Program

Required N N Section 2.5.27

42. Schedule the Resubmit 
Interface Process

Required N N Section 2.5.28

43. Schedule the Resubmit 
Waiting Transactions 
Program

Required N N Section 2.5.29

44. Final Synchronize 
On-Hand Balance between 
Inventory and Install Base

Required NA NA Section 2.5.30

Table 2–1 Setup Checklist for New Users of Oracle Install Base

Step
Number Title

Required or
Optional Seeded? Extensible?

Section
Reference
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2.3 Related Setup Steps within Other Oracle Applications

2.3.1 Synchronize On-Hand Balance between Inventory and Install Base
To maintain life-cycle tracking for all items that are to be tracked in Install Base, it 
maintains a mirror image of what is in Inventory. For new implementations of 
Install Base, all on-hand quantities of Install Base trackable items must be issued out 
of Inventory. Oracle suggests that you use the miscellaneous issue transaction in 
Inventory to do this step.

You receive these items back into Inventory at Step 44 in the checklist. Refer to 
Section 2.5.30 for related information.

2.3.2 Set Up Inventory Serial Control at the Master Level
Install Base requires that the serial control of Install Base trackable items is set up in 
the master organization for Install Base to support the continuous tracking through 
all organizations. 

2.3.3 Set Up Install Base Items in the Item Master
All items that need to be tracked in Oracle Install Base and Enterprise Install Base 
are set up as Install Base trackable, whether they are tangible, 
inventory-transactable, shippable items such as a computer or intangible, 
non-inventory-transactable, non-shippable items such as a license. An item can 
either be Network Logistics trackable or a service item such as a contract. It cannot 
be both. 

For an item to be set up as trackable in Install Base, Installed Base Trackable has to 
be selected on the Service tabbed page of the Master Item window. Depending on 
the revision of the Inventory application, Installed Base Trackable may not be on the 
Service tabbed page. In this case, select Network Logistics Trackable on the 
Inventory tabbed page of the Master Item window. An item has to be set up in the 
global master item, and it must be assigned to the inventory organizations that use 
it. 

To create a warranty for a product instance, the service item of the contract must be 
part of the BOM of the top assembly item. 

Instances can be created online and through interfaces such as Inventory receipt and 
WIP assembly completion. 
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Refer to Section 1.3.2, "ERP-Install Base Integration" for information about instance 
creation through integration.

For more information about how to set up items in Item Master, consult Oracle 
Inventory implementation guides.

2.3.4 Set Up Parties
The parties associated with item instances in Install Base need to be defined in HZ_
PARTIES first.

For more information about how to set up parties, consult the Oracle Accounts 
Receivable Implementation Guide.

2.3.5 Set Up Vendors
The vendor parties associated with item instances in Install Base need to be defined 
in PO_VENDORS first. For more information about how to set up vendors, consult 
Oracle Purchasing implementation guides.

2.3.6 Set Up Employees
Employees can be associated with Install Base item instances as parties. To do so, 
employees must be defined in HR tables first.

For more information about how to set up employees, consult Oracle Human 
Resources Applications implementation guides.

2.3.7 Set Up Party Accounts
The parties associated with item instances in Install Base can have a number of 
accounts associated with them. These accounts need to be defined in the HZ_
CUST_ACCOUNTS table before referencing them in install Base.

For more information about how to set up party accounts, consult the Oracle 
Accounts Receivable Implementation Guide.

2.3.8 Set Up Party Contacts
Install Base can maintain the contacts to parties associated with item instances. 
These contacts to parties must be defined in the HZ_PARTIES table using the 
Contact Center window before referencing them in Install Base.
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For more information about how to set up party contacts, consult the Oracle 
Accounts Receivable Implementation Guide.

2.3.9 Confirm the Setup of the Oracle Service Fulfillment Manager Event Queue
For instructions on setting up the Oracle Service Fulfillment Manager Event Queue, 
refer to the Oracle Service Fulfillment Manager Implementation Guide. 

Install Base is dependent on SFM’s Event Manager Queue Service. The setup steps 
for SFM’s Event Manager Queue Service are listed below. 

SFM Installation & SFM Post-Install Steps (One-Time) 
It is critical that the Generic Service Management (GSM) post-install steps are done 
correctly. Otherwise, the SFM Event Manager Queue Service will not be activated. 
Contact Oracle Customer Support for a list of specific patch requirements. 

Additional Manual Installation Step (One-Time) 
SFM provides a Queue Console with which a DBA can see the number of events 
sitting in the Event Manager Queue Service. When SFM is installed in Shared Mode, 
which is the case for Install Base, the Queue Console form must be manually 
compiled. This form is in $XDP_TOP/forms/US/XDPADQCS.fmb.

Deactivate Services that Are Not Used (One-Time) 
When a DBA starts the Internal Concurrent Manager (ICM), this automatically 
starts SFM Services that are registered with GSM. Because Install Base is using only 
the SFM Event Manager Queue Service, all other SFM Services can be deactivated. 
To do this: 

Steps

1. Log into Oracle Applications with SFM System Administrator responsibility. 

2. From the Navigator menu, select Concurrent > Administer Manager. 

3. Deactivate all services that appear except the SFM Event Manager Queue 
Service. 

Setup to ensure the Serializability of transactions processed in Install 
Base (One Time) 
At any one time several transactions originating from Inventory and Order 
Management can be processed in Install Base. To eliminate the errors that can occur 
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due to the concurrent execution of these transactions, the following steps must be 
performed to ensure the serilizability of these transactions:

Steps

1. Log into Oracle Applications. 

2. Navigate to System Administrator > Concurrent > Manager > Define. 

3. Query for the Manager SFM Event Manager Queue Service. 

4. Click Work Shifts.

5. Change the processes to 1. 

6. In the Parameter field, change the value of XDP_DQ_INIT_NUM_THREADS to 
1  (XDP_DQ_INIT_NUM_THREADS=1). 

7. Stop and restart the SFM Event Manager Queue. 

Monitor SFM’s Event Manager Queue Service (Daily Basis) 
If a DBA wants to check whether SFM’s Event Manager Queue Service is running, 
this can be done from any of the following places: 

■ SFM’s Queue Console - this provides the status as well as the queue size. 

■ Concurrent Manager’s Administer Manager Form - this provides the status.

■ Oracle Application Manager’s SFM page - this page is in HTML. It allows a 
DBA to see the Event Manager Queue Service status and Queue Size. 

2.3.10 Set Up the Action Menu in Order Management
This menu setup is required so that Transaction Details and Maintain Systems 
windows are set up as part of the Action menu.

Steps
1. Log on to Oracle Applications with the System Administrator responsibility.

2. Choose Applications > Menu.

3. Choose View > Query By Example > Enter.

4. In the Menu field, enter the string ONT_SALES_ORDERS.

5. Choose View > Query By Example > Run.

6. Go to the last record in the multi-record details block.
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7. Choose File > New to create new records with the following Field Values:

a. Seq: Choose the next sequence.

b. Function: Select Installed Base Transaction Details from the list of values.

c. Seq: Choose the next sequence.

d. Function: Select IB Maintain Systems from the list of values.

8. Save the record.

2.3.11 Set Up the Order Management Workflow
For sales orders to interact with Install Base for non-shippable items, the 
background workflow must be run in a certain sequence or the sales order 
workflow must be set up. 

2.3.11.1 Interface Non-Shippable Items to Install Base without Workflow 
Customization
To interface non-shippable items to Install Base without Workflow customization:

Steps
1. Place an order for a non-shippable item through Order Management.

2. Book the order.

3. Run the Workflow background process with the following parameters:

■ Item Type = Sales for Communications

■ Minimum Threshold = Null

■ Maximum Threshold = Null

■ Process Deferred = Yes

■ Process Timeout = No

■ Process Stuck = No

4. After the above process has completed successfully, run the Workflow 
background process with the following parameters:

■ Item Type = OM Order Line

■ Minimum Threshold = Null

■ Maximum Threshold = Null
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■ Process Deferred = Yes

■ Process Timeout = No

■ Process Stuck = No

5. After the above process has completed successfully, run the Workflow 
background process with the following parameters:

■ Item Type = Sales for Communications

■ Minimum Threshold = Null

■ Maximum Threshold = Null

■ Process Deferred = Yes

■ Process Timeout = No

■ Process Stuck = No

6. After you are sure the process has completed successfully, you can see an 
instance created in Install Base. These workflow processes can be scheduled to 
run at regular intervals as required.

2.3.11.2 Interface Non-Shippable Items to Install Base with Workflow 
Customization
To update the workflow in Workflow Builder for Fulfill-only workflows:

Steps
1. Log on to Oracle Workflow Builder on your client PC using the apps user ID, 

password, and connect string to connect to the database to customize the 
workflows.

2. Select Sales for Communication, OM Order Line from Show Item Types 
window.

3. Move them to the Visible Window.

4. Click Open.

5. In the navigator, select Sales for Communication > Functions > Installed Base 
Interface.

6. Right-click and choose Copy.

7. Select OM Order Line > Functions. 

8. Right-click and choose Paste.
2-10 Oracle Install Base Implementation Guide



Related Setup Steps within Other Oracle Applications
9. Select OM Order Line > Processes. 

10. Right-click the Order Line that you want to customize, and choose Copy.

11. Right-click again and choose Paste.

12. Enter a different internal name for the newly created process.

13. Double-click the newly created process to open it.

14. Click New Function on the Top icon bar.

15. Click the Internal Name Pull Down list, and choose Install Base Interface.

16. Delete the line after the Fulfill function (the line going out from Fulfill to the 
node after Fulfill).

17. Pull the Install Base Interface after the Fulfill function.

18. Right-click Fulfill, and drag it to Install Base Interface.

19. Right-click Install Base Interface, and drag it to the node after Fulfill. For the 
option results, choose Any.

20. Save and Exit.

To set up Order Management changes in applications:

Steps
1. Order Management Super User > Setups > Transaction Types.

2. Query the desired transaction type that you plan to use on the sales orders.

3. Click Assign Work Flows.

4. End-date the current line type that used the seeded workflow. 

5. Create another record with the same line type as the one that was expired. 

6. Tie the Customized Workflow process name created in Workflow to the this line 
type.

To process sales orders:

Steps

1. Place an order for a non-shippable item through Order Management using this 
customized line type.

2. Book the sales order.

3. Run the OM Workflow background process or schedule it. 
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4. View the instance created in Install Base.

2.4 Related Setup Steps within Oracle Enterprise Install Base

2.4.1 Run the License Manager Program
Run this program to license Enterprise Install Base only if you have not installed 
Enterprise Install Base. It enables Enterprise Install Base functionality for inventory 
receipts and other processing required for Install Base.

2.4.2 Verify the Setup of Four Profile Options for Enterprise Install Base
This is required only if you have not installed Enterprise Install Base. Confirm that 
the following profile options were set up:

■ MO: Operating Unit (Indicates the Inventory Master Organization)

■ CSE: Debug Option (Y or N)

■ CSE Debug Log Directory (path name)

■ CSE Bypass Event Queue (N) 

2.4.3 Verify Location IDs in HZ_LOCATIONS
The following locations must be defined in the HZ_LOCATIONS table before using 
them in Install Base:

These fixed location IDs must be defined in HZ_LOCATIONS first before setting up 
the Installation Parameters in a later step. For more information about how to set up 
locations, consult the Oracle Customer Care Implementation Guide.

Table 2–2 Locations that Must Be Defined in the HZ_LOCATIONS Table

Location Description

Project A fixed location ID defined for Projects in HZ_LOCATIONS 
table.

WIP A fixed location ID defined for WIP in HZ_LOCATIONS table.

IN_TRANSIT A fixed location ID defined for In-transit in HZ_LOCATIONS 
table.

PO A fixed location ID defined for PO in HZ_LOCATIONS table.
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2.4.4 Verify Codes for Asset Update Statuses
Type: CSI Lookup

Lookup Type: CSI_ASSET_UPDATE_STATUS

Access Level: Non-extensible

Verify that the following values are already seeded for CSI_ASSET_UPDATE_
STATUS.

Refer to the Oracle Enterprise Install Base Implementation Guide for details.

2.5 Setup Steps within Oracle Install Base
Most of these steps are performed through navigation to Install Base Setups and 
Lookups as shown in Figure 2–1. You access these through the Oracle Installed Base 
Admin responsibility. Online help for the Install Base Lookups window provides 
information about lookups.

Table 2–3 Seeded Values for CSI_ASSET_UPDATE_STATUS

Lookup Code Meaning Description

IN-SERVICE In-Service In-Service

RETIRED Retired Retired
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Figure 2–1 Navigation for Install Base Setups

2.5.1 Set Up Installation Parameters
Install Base keeps a set of customer-specific installation parameters defined in a 
table at setup time. You use the Installed Parameters window to provide them. After 
you define them and select Freeze, the fields cannot be updated. 

The migration procedure populates the table with default data. After migration, you 
open the window for update before the freeze takes effect. 

Oracle Installed Base Admin responsibility: Setups > Install Parameters
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The following list defines the fields in the Installed Parameters window.

■ Party Name: The internal party name of the Install Base organization. This 
organization is the owner of all instances that are mapped to Inventory on-hand 
balances. This party ownership is the only internal party supported. Product 
transfer from this party is not supported. This organization cannot be changed 
after it is set. For upgrade customers, this setup is done by setting a profile: 
Service: Migration Organization for Employee Service Requests. Caution: This 
party should not be used as the object of merge in the TCA merge routines.

■ Full Dump Frequency: The number of updates of an Install Base record before a 
full image of the record is dumped into the history table. For example, 
HISTORY_FULL_DUMP_FREQUENCY=10 means that every 10th update 
made to a record in any Install Base table is followed by a complete dump of 
record’s image (changed as well as unchanged columns) in the corresponding 
history table. For the remaining nine updates, only the changed values are 
dumped into the history table.

■ Project Location: The location defined for the use of instances in Project.

■ WIP Location: The location defined for use of instances in WIP.

■ In-Transit Location: The location defined for use of instances in transit between 
organizations.

■ PO Location: The location defined for use of instances in WIP outside 
processing. 

■ Category Set Name: The name of the category set to be used in the additional 
attributes setup.

■ All Parties Locations: If selected, then all parties and locations are made 
available for transfer and location change. If it is cleared, then only related 
parties and locations are made available for transfer and location changes.

■ Freeze: After this is selected, the parameters cannot be changed.
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Figure 2–2 Installed Parameters Window

2.5.2 Set Up Codes for Party-Account and Party-Contact Relationship Types
The instance party account relationship codes define the types of relationship that 
can be set up for parties, accounts, and contacts. The six seeded relationship types 
are as follows:

Table 2–4 Seeded Relationship Types

Name
Party 
Selected?

Account 
Selected?

Contact 
Selected?

OWNER Y Y N

BILL-TO Y Y Y

SHIP-TO Y Y Y

SOLD-TO Y Y N

TECHNICAL N N Y

SERVICE-ADMINISTRATION N N Y
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You can set up additional relationship type codes for party, account, and contact 
and define them by selecting the appropriate checkboxes in the following window.

Figure 2–3 Window for Instance Party Account Relationship Types

For more information about setting up these codes, consult the Oracle Customer Care 
Implementation Guide.

2.5.3 Verify Codes for Instance Relationship Types
Install Base supports the eight types of instance-to-instance relationship shown in 
Table 2–5.

Table 2–5 Relationship Type Codes

RELATIONSHIP TYPE 
CODE NAME 

RELATIONSHIP 
DIRECTION

COMPONENT-OF Component Of Subject-to-Object

MEMBER-OF Member Of Subject-to-Object

PROVIDED-BY Provided By Subject-to-Object

INSTALLED-ON Installed On Subject-to-Object
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Component-of is the only relationship type that supports the flow-down of the 
current location and the installation location from parent to child. 

From the OM-IB shipment/fulfillment integration, component-of configuration can 
be created through the BOM explosion, PTO model, and ATO model. Refer to 
Section 1.3.5 for details on this integration.

From the WIP-IB integration, component-of configuration can be created through 
the WIP assembly completion into inventory. Refer to Section 1.3.6 for details on 
this integration.

Replaced-by and replacement-for relationship types are created only by the OM-IB 
integration using the Transaction Details window. They are set up as 
transaction only. For further information, refer to "Using the Transaction 
Details Window" in Oracle Install Base Concepts and Procedures.

All other relationship types can be used in setting up multiple relationship types for 
the same instance. No location flow-down rules apply. 

Verify that the standard instance statuses are seeded by checking the content of the 
Relationship Type Codes window.

CONNECTED-TO Connected To Bi-directional

UPGRADED-FROM Upgraded From Subject-to-Object

REPLACEMENT-FOR
[for transaction only]

Replacement For Subject-to-Object

REPLACED-BY
[for transaction only]

Replaced By Subject-to-Object

Table 2–5 Relationship Type Codes

RELATIONSHIP TYPE 
CODE NAME 

RELATIONSHIP 
DIRECTION
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Figure 2–4 Relationship Type Codes Window

2.5.4 Verify Extended Attribute-Level Codes
Type: CSI Lookup

Lookup Type: CSI_IEA_LEVEL_CODE

Access Level: Non-Extensible

Verify that the following values are already seeded for CSI_IEA_LEVEL_CODE

Table 2–6 describes the four levels of extended attributes that you can define for 
Install Base items. These are the extended attributes that are used in the Extended 
Attribute page of the application.

Table 2–6 Levels of Extended Attributes for Install Base Items

Lookup Code Meaning Description

GLOBAL Global Applicable to all item instances in 
Install Base

CATEGORY Category Applicable to the items of the 
category for which the extended 
attributes are defined
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Use the Install Base Lookups window to verify that these codes are seeded for type 
CSI_IEA_LEVEL_CODE. 

Figure 2–5 Lookups for Extended Attribute Level Codes

2.5.5 Set Up Extended Attribute Pools
Type: CSI Lookup

Lookup Type: CSI_EXTEND_ATTRIB_POOL

ITEM Item Applicable to all instances of the 
item type for which the extended 
attribute is defined.

INSTANCE Instance Applicable only to the instance for 
which the extended attribute is 
defined.

Table 2–6 Levels of Extended Attributes for Install Base Items

Lookup Code Meaning Description
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Access Level: Extensible

Values are not seeded for this code.

Optionally define extended attribute pools with code values such as color and 
grade.

To set up extended attributes, the name and code of the attribute have to be set up 
in the pool of attributes. This is where users can define an attribute’s name, code, 
and description to be used in the LOV when the extended attribute is set up.

Figure 2–6 Lookups for Extended Attribute Pool

2.5.6 Set Up Extended Attribute Classifications
Type: CSI Lookup

Lookup Type: CSI_IEA_CATEGORY

Access Level: Extensible

Values are not seeded for this code.

Optionally define extended attribute classifications such as chemical and physical.
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To set up extended attribute classifications, the name and code of the attribute have 
to be set up in the pool of attributes (see Section 2.5.5). Then each attribute can be 
classified into category. This is the table where a user can define the categories by 
which an attribute can be classified from a LOV in the extended attribute setup.

Figure 2–7 Lookups for Extended Attribute Classifications

2.5.7 Set Up Extended Attributes
The extended attributes used for Install Base item instances must be defined in the 
Extended Attributes window. 

Four levels of extended attributes can be defined for Install Base items:

■ Global: Global Level Extended Attributes are applicable to all the item instances 
in install Base.

■ Item Category: Category level extended attributes are applicable to the items of 
the category for which the extended attributes are defined.

■ Inventory Item: Item level extended attributes are applicable to all the instances 
of the item type for which the extended attribute is defined.
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■ Instance: Instance level extended attributes are applicable only to the instance 
for which the extended attribute is defined.

Use the Install Base Extended Attributes window to define these attributes.

Figure 2–8 Extended Attributes Window

2.5.8 Verify Accounting Classification Codes
Type: CSI Lookup

Lookup Type: CSI_ACCOUNTING_CLASS_CODE

Access Level: Non-extensible

Verify that the following values are already seeded for CSI_ACCOUNTING_
CLASS_CODE:

Table 2–7 Accounting Classification Codes

Lookup Code  Meaning Description

INV Inventory Inventory

ASSET Asset Asset
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Figure 2–9 Setup for Accounting Classification Codes

2.5.9 Set Up Instance Type Codes
Type: CSI Lookup

Lookup Type: CSI_INST_TYPE_CODE

Access Level: Extensible

No values are seeded for CSI_INST_TYPE_CODE.

Define the instance type codes used by your organization. You can enter any value. 
Examples of instance types are Hardware, Software, and Service. This code is an 

WIP Work In Process Work In Process

PROJECT Project Project

CUST_PROD Customer Product Customer Product

Table 2–7 Accounting Classification Codes

Lookup Code  Meaning Description
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optional classification for an instance and is used in the general attributes page in 
the application. 

Figure 2–10 Setup of Instance Type Codes

2.5.10 Verify Codes for Instance Location Sources
Type: CSI Lookup

Lookup Type: CSI_INST_LOCATION_SOURCE_CODE

Access Level: Non-Extensible

Verify that the following values are already seeded for CSI_INST_LOCATION_
SOURCE_CODE.

Table 2–8 Instance Location Source Codes

Lookup Code Meaning Description

HZ_LOCATIONS HZ Location The Location is defined in HZ_
LOCATIONS table.
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These are the types of locations that are supported in Install Base.

HZ_PARTY_SITES HZ Party Site Item is at an external party site. The 
location is defined in HZ_PARTY_SITES 
table.

INTERNAL_SITE Internal Site Item is at an internal site. The location is 
defined in HR_LOCATIONS table.

INVENTORY Inventory Item is in inventory.

IN_TRANSIT In-Transit Item is in Transit. Location is defined by 
in-transit order line ID.

PO PO Location is defined in PO_LINES_ALL 
table.

WIP Work in Process Item is in WIP.

PROJECT Project Item is in Project.

VENDOR_SITE Vendor Site Item is at a vendor site. Location is defined 
in PO_VENDOR_SITES_ALL table.

Table 2–8 Instance Location Source Codes

Lookup Code Meaning Description
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Figure 2–11 Setup for Instance Location Source Codes

These are the different kinds of locations that a product can have.

2.5.11 Verify Party Sources
Type: CSI Lookup

Lookup Type: CSI_PARTY_SOURCE_TABLE

Access Level: Non-Extensible

Verify that the following values are already seeded for CSI_PARTY_SOURCE_
TABLE.

Table 2–9 Party Sources Codes

Lookup Code Meaning Description

HZ_PARTIES HZ_PARTIES Party is defined in HZ_PARTIES table.

PO_VENDORS PO_VENDORS Party is defined in PO_VENDORS table.

EMPLOYEE HR Employee Party is defined in Party is defined in PER_
ALL_PEOPLE_F table.
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This table is not extensible. It defines the types of parties that are supported in 
Install Base for an instance. For example, an owner can be a party (such as a 
customer), an employee, or a vendor. A party that provides support can be a team 
or a group.

Figure 2–12 Setup for Party Sources

2.5.12 Set Up Codes for Instance-Organization Unit Relationship Types
Type: CSI Lookup

Lookup Type: CSI_IO_RELATION_TYPE_CODE

Access Level: Extensible

Verify that the following values are already seeded for the CSI_IO_RELATION_
TYPE_CODE
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Define new instance-to-operating units organization codes specific to your 
organization. Install Base has limited functionality behind this 
instance-organization unit association. It is for information only. The SOLD-FROM 
relationship is created each time an instance is sold from an organization.

Figure 2–13 Setup of Instance-Organization Relationship Type Codes

2.5.13 Set Up Version Labels
Type: CSI Lookup

Table 2–10 Codes for Instance-Organization Unit Relationship Types 

Lookup Code Meaning Description

RECEIVED_INTO Received into The Received Into item is received into this 
organization unit.

SERVICED_BY Serviced by The Serviced By item is serviced by this 
organization unit.

SOLD_FROM Sold from The item is sold from this organization unit.

SERVICE_BILLED_
FROM

Service billed from The organization that gets the credit from 
Billing.
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Lookup Type: CSI_INSTANCE_VERSION_LABELS

Access Level: Extensible

Verify that the following values are already seeded for CSI_INSTANCE_VERSION_
LABELS.

Define new version label codes to be used in your organization. This table of codes 
is used as a source of the LOV for the profile option setup in Default Version Label. 
It is used as a default when an instance is first created. 

Figure 2–14 Lookups for Version Labels

Table 2–11 Setup of Version Labels

Lookup Code Meaning Description

AS-CREATED As-Created As-Created

AS-MAINTAINED As-Maintained As-Maintained

AS-ORDERED As-Ordered As-Ordered
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2.5.14 Set Up System Type Codes
Type: CSI Lookup

Lookup Type: CSI_SYSTEM_TYPE

Access Level: Extensible

No values are seeded for CSI_SYSTEM_TYPE.

When a system is created, a type can be selected from an LOV. This table is where 
user-defined system types can be set up for use in the LOV.

Use the setup window to define system types for your organization. They are used 
in the Systems page of the application to define systems.

Figure 2–15 Setup of System Types

2.5.15 Set Up Split Process Reasons
Type: CSI Lookup

Lookup Type: CSI_SPLIT_REASON_CODE

Access Level: Extensible
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No values are seeded for CSI_SPLIT_REASON_CODE

Define split reasons to be used in your organization.

When an instance with a quantity greater than 1 is split, a reason code can be 
selected for the reason for the split. This is the window where the reason codes can 
be set up for use in an LOV.

Figure 2–16 Setup of Split Reason Codes

2.5.16 Set Up Instance Statuses
Instance statuses are user-extendible and are defined using a combination of 
settable flags. 
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Table 2–12 CSI Instance Statuses

There are 16 seeded statuses.

Name Terminate

Status 
Change 
Allowed

Service 
Allowed

Request 
Allowed predefined Updatable

Created N Y Y Y Y N 

Expired Y Y N N Y N

Latest N Y Y Y Y N 

Loaner N Y N Y Y N

Repaired N Y Y Y Y N

Replaced N N N N Y N 

Replaced - 
No Return

Y Y N N Y N

Replacement N Y Y Y Y N

Return for 
Replacement

Y Y N N Y N

Returned for 
Credit

N Y N N Y N

Returned for 
Repair

N Y Y N Y N

Returned for 
Upgrade

N Y Y N Y N 

Returned 
Loaner

N Y N N Y N

Spare Part N Y Y Y Y N

Updated N Y Y Y Y N

Upgraded N Y Y Y Y N
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The meaning of the checkboxes is as follows:

■ Terminated: Sets the instance to be terminated.

■ Status Change Allowed: The status can be changed for an instance currently 
bearing this status.

■ Service Allowed: Service contract can be active for the instance with this status. 
If set to No, then the service contract will be called to terminate the contract

■ Requests Allowed: Service request can be created for an instance with this 
status.

■ Pre-Defined: Seeded

■ Updatable: The checkboxes on this status can be updated

Figure 2–17 Instance Statuses Window

2.5.17 Set Up Source Transaction Types
Before any source transaction can be used in the LOV for a transaction subtype, it 
must be defined in this setup. All integration sources and transaction types must be 
defined here before they can be used to update Install Base. Values can be seeded or 
user-defined.

Window Fields
Application Name: An LOV of Oracle Applications that can be set up to integrate 
into Install Base.
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Transaction Type: The user-defined name of the kind of transaction that integrates 
with Install Base from the application named. 

Transaction Name: The user-defined name of the transaction.

Description: The user-defined description of the transaction.

Source Object is for future use

In Out is for future use

Figure 2–18 Source Transaction Types Window

2.5.18 Set Up Transaction Subtypes
Transaction types and subtypes are used to specify the kinds of transactions that the 
interface program can use. The main purpose of the Source Transactions Subtypes 
window is to specify what kind of update can be done to an Install Base instance 
when transactions come from either ERP or CRM. For this release the data comes 
from Order Management, Field service, and Order Capture. In Order Management 
you can go into the transaction relation details to pick one of the transactions being 
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defined here. Here you define these transactions and the kind of actions they can 
perform on the source instance, the non-source instance, and the parent instance. 

Figure 2–19 Source Transaction Subtypes Window

Window Regions

Transaction Subtypes Region
This region is used to define the name of the transaction subtype. The name can 
come form two sources, depending whether the Service Type checkbox is selected 
or not:

■ If Service Type is selected, then the LOV comes from the Service Transaction 
Billing Types setup. 
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■ If Service Type is not selected, then the LOV comes from the Install Base 
Transaction Type code setup. Refer to the section on ’Transaction Subtype from 
the Non-Service process’. 

Source Info Region
This region is used to define the specific actions to take for the instance being 
transacted. In the case of the sales order line, it can the part being sold on the sales 
order line. 

Reference Required: Specifies whether an Install Base product number or reference 
number is mandated for this transaction type. In the case of a return of a 
non-serialized item, this Install Base product number is always required for the 
Install Base interface to know which instance to update. If the part is a serialized 
item, then this product number is not mandated because the interface program can 
pick up the serial number from the receipt transaction.

Change Owner: Indicates whether a change of ownership is to take place for this 
transaction type. If checked, then a change of ownership is to take place.

Change Owner To: Selects the ownership change to be Internal or External. For 
example, when returning an item for repair, the ownership need not be changed. 
For a sales order of a shipped item, the ownership can be changed to External.

Status: Defines the status to be updated for this instance. For example, when an 
instance is returned for repair, its status is changed to Returned for Repair.

Return Reqd: Requires a return date to be entered on the Installation detail for this 
transaction. Not mandatory.

Revision Reqd: Requires a revision to be entered on the Installation detail for a 
revision controlled instance. Not mandatory.

Non Source Info Region
This region is to define the specific actions to make for the instance being related to 
the instance being transacted. 

If the non-source installation detail uses the transaction subtype, then the action to 
be taken for the non-source instance comes from this region. For example, in order 
to use this subtype for a to-be-replaced instance in the non-source installation detail, 
Reference Reqd must be selected, and a status specified. 

Reference Reqd: Specifies whether an Install Base product number or reference 
number is mandated for this transaction type. 
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Change Owner: Indicates whether a change of ownership is to occur for this 
transaction type. If checked, then change of ownership is to occur.

Change Owner To: Selects the ownership change to be Internal or External. 

Status: Defines the status to be updated for this instance. For example, the status of 
a replaced instance can be Replaced.

Return Required: Requires a return date to be input on the transaction detail for this 
transaction. 

Parent Info Region
This region is for future use. 

Source Transaction Types Region
This region is to define the source application from which the transaction being 
defined comes.

This is a LOV of transaction types defined first in the Source Transaction Type 
setup. For example, the Sell transaction subtype comes from the Order Management 
application OM_SHIPMENT. Return for Credit comes from the Order Management 
application RMA_RECEIPT type.

Other examples of application sources are Field Service and Order Capture.

The In Out field is not being used for this release.

Default: Indicates whether this transaction subtype is to be used as the default 
subtype for that source transaction type and application being defined. For 
example, Sell is the default subtype for OM_SHIPMENT/ Order Management 
Ship/Fulfill sales order lines. Return for Repair is the default subtype for the RMA_
RECEIPT/ Order Management Return line.

Update IB: Indicates whether this subtype/Source transaction type combination is 
used to update Install Base or not. For example, some subtypes set up for the Field 
Service application updates Install Base only from Field Service.

2.5.19 Set Up the Transaction Subtypes LOV from non-Service Processes
Type: CSI Lookup

Lookup Type: CSI_IB_TXN_TYPE_CODE

If the Service Type checkbox of the Source Transactions Subtypes window is not 
selected, then the LOV comes from the Install Base Transaction Type Codes setup. 
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This setup is found in the Install Base Administrator /Lookup/ CSI_IB_TXN_
TYPE_CODE table. Six seeded values are used in the transaction subtype setup, and 
more can be user-defined. 

Figure 2–20 Subtypes LOV from Non-Service Processes

2.5.20 Verify Transaction Status Codes
Type: CSI Lookup

Lookup Type: CSI_TRANSACTION_STATUS_CODE

Access Level: System

Values are seeded for this code.

These are the status codes used for integration transactions
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Figure 2–21 Lookups for Transaction Status Codes

2.5.21 Verify Transaction Error Source Types
Type: CSI Lookup

Lookup Type: CSI_TXN_ERRORS_SOURCE_TYPES

Access Level: System

Values are seeded for this code.

When an integration transaction is processed with an error, it is posted to the error 
table with one of the these error source types, which indicate where an error comes 
from.
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Figure 2–22 Lookups for Transaction Error Source Types

2.5.22 Create Business Users
Install Base supports 38 different permissions with specific access and update 
privileges. See Table 2–13 for supported permissions. 

A role is a combination of permissions. Install Base ships with two pre-defined 
roles: CSI_END_USER for business users and CSI_NORNAL_USER for internal 
agent users.

Table 2–13 Permissions Supported by Install Base

Name Description Agent Customer

CSI_ACCT_ACCESS_
ONLY

Restricts the users access to Install Base products 
based on an Account 

N Y

CSI_ADDI_ATTR_
UPDATE

Update permission for the CSI Additional Attributes 
page.

Y Y

CSI_ADDI_ATTR_
VIEW

View permission for the CSI Additional Attributes 
page.

Y
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CSI_ALL_ACCT_
ACCESS

Allows access to Install Base Products across 
accounts and parties.

Y N

CSI_ASSET_UPDATE Update permission for the Asset page Y N

CSI_ASSET_VIEW View permission for the Asset page Y N

CSI_CONTACT_
DETAIL_UPDATE

Update permission for the Contact Detail page Y Y

CSI_CONTACT_
DETAIL_VIEW

View permission for the Contact Detail page Y Y

CSI_CONTRACT_
UPDATE

Update permission for the Contract page Y Y

CSI_CONTRACT_
VIEW

View permission for the Contract page Y Y

CSI_COUNTER_
UPDATE

Update permission for the Counter page Y Y

CSI_COUNTER_VIEW View permission for the Counter page Y Y

CSI_CREATE_INST_
UPDATE

Update permission for the Create Instance page Y Y

CSI_CREATE_INST_
VIEW

View permission for the Create Instance page Y Y

CSI_CREATE_SYS_
UPDATE

Update permission for the CSI Create System page Y N

CSI_CREATE_SYS_
VIEW

View permission for the CSI Create System page Y N

CSI_CUSTOMER_
VIEW

This permission should be assigned to any user that 
is a customer

N Y

CSI_DOWNLOAD Permission to download product search results. Y Y

CSI_EXPIRE_
INSTANCE

Users with this permission can change the instance 
status to any terminable status. The user also needs 
to have the CSI_INST_STATUS_UPDATE 
permission.

Y Y

CSI_GENERAL_
ATTRIB_CUST_ONLY

Makes certain Customer product attributes read only N Y

CSI_INST_CONFIG_
UPDATE

Update permission for the Instant Config page Y Y

Table 2–13 Permissions Supported by Install Base

Name Description Agent Customer
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CSI_INST_CONFIG_
VIEW

View permission for the Instant Config page Y Y

CSI_INST_GENERAL_
UPDATE

Update permission for the Instant General page Y Y

CSI_INST_GENERAL_
VIEW

View permission for the Instant General page Y Y

CSI_INST_NOTES_
UPDATE

Permission to update the Oracle Install Base instance 
notes.

Y Y

CSI_INST_NOTES_
VIEW

Permission to view the Oracle Install Base instance 
notes.

Y Y

CSI_INST_
QUANTITY_UPDATE

Users with this permission are allowed to update 
instance quantity

Y Y

CSI_INST_STATUS_
UPDATE

Users with this permission can update the instance 
status

Y Y

CSI_LATEST_
TRANSACTION_
UPDATE

Update permission for the Latest Transaction page Y Y

CSI_LATEST_
TRANSACTION_
VIEW

View permission for the Latest Transaction page Y Y

CSI_MERCHANT_
VIEW

this permission should be assigned to any user that is 
an agent of a merchant

Y N

CSI_
OPERATINGUNIT_
UPDATE

Update permission for the Operating Unit page. Y N

CSI_
OPERATINGUNIT_
VIEW

View permission for the Operating Unit page. Y N

CSI_
ORGANIZATION_
VIEW

Permission to view organizations Y N

CSI_PARTY_
ACCOUNT_UPDATE

Update permission for the Party Account page Y N

CSI_PARTY_
ACCOUNT_VIEW

View permission for the Party Account page Y N

Table 2–13 Permissions Supported by Install Base

Name Description Agent Customer
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CSI_PARTY_
CONTACT_UPDATE

Update permission for the Party Contact page Y Y

CSI_PARTY_
CONTACT_VIEW

View permission for the Party Contact page Y Y

CSI_PARTY_
SUMMARY_UPDATE

Update permission for the Party Summary page Y N

CSI_PARTY_
SUMMARY_VIEW

View permission for the Party Summary page Y N

CSI_PARTY_UPDATE Update permission for the Party page Y N

CSI_PARTY_VIEW View permission for the Party page Y N

CSI_PERZ_EDIT_
UPDATE

Update permission for the Personalized Edit page Y Y

CSI_PERZ_EDIT_
VIEW

View permission for the Personalized Edit page Y Y

CSI_PRICING_
UPDATE

Update permission for the Pricing page Y Y

CSI_PRICING_VIEW View permission for the Pricing page Y Y

CSI_PROPERTY_
READ

Read the CSI Properties Y Y

CSI_PROPERTY_
UPDATE

Update the CSI Properties N N

CSI_REPAIR_ORDER_
UPDATE

Update permission for the Repair Order page Y Y

CSI_REPAIR_ORDER_
VIEW

View permission for the Repair Order page Y Y

CSI_SEARCH_ASSET_
RES_UPDATE

Update permission for the Search Asset Result page Y N

CSI_SEARCH_ASSET_
RES_VIEW

View permission for the Search Asset Result page Y N

CSI_SEARCH_ASSET_
UPDATE

Update permission for the Search Asset page Y N

CSI_SEARCH_ASSET_
VIEW

View permission for the Search Asset page Y N

Table 2–13 Permissions Supported by Install Base

Name Description Agent Customer
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CSI_SEARCH_
PRODUCT_UPDATE

Update permission for the Search Product page Y Y

CSI_SEARCH_
PRODUCT_VIEW

View permission for the Search Product page Y Y

CSI_SEARCH_SYS_
UPDATE

Updating systems search results. Y N

CSI_SEARCH_SYS_
VIEW

Viewing the systems search page. Y N

CSI_SEARCH_
TRANSACTION_
UPDATE

Update permission for the Search Transaction page Y N

CSI_SEARCH_
TRANSACTION_
VIEW

View permission for the Search Transaction page Y N

CSI_SERVICE_
REQUEST_UPDATE

Update permission for the Service Request page Y Y

CSI_SERVICE_
REQUEST_VIEW

View permission for the Service Request page Y Y

CSI_SHOW_ALL_
CONTACTS

Allows Install Base User to view all types of contacts Y N

CSI_SHOW_ALL_
LOCATIONS

Allows the Install Base user to view all types of 
locations 

Y N

CSI_SHOW_ALL_
PARTIES

Allows the user to View all types of parties including 
Employees CSI

Y N

CSI_SHOW_EXT_
CONTACTS

Restricts Install Base User to view only the external 
contacts

N Y

CSI_SHOW_EXT_
LOCATIONS

Restricts the Install Base user to view only external 
locations

N Y

CSI_SHOW_EXT_
PARTIES

Restricts the user to View only the External parties N Y

CSI_SHOW_INST_
CUSTOMER_MENU

Permission to have the Install Base Customer facing 
instance details Menu

N Y

CSI_SHOW_INST_
MENU

Permission to have the Install Base Agent facing 
instance details Menu

Y N

Table 2–13 Permissions Supported by Install Base

Name Description Agent Customer
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Use this procedure to create a business user and assign the pre-defined CSI_END_
USER role and the responsibility of Oracle Install Base customer.

Steps
1. Login to the Oracle eBusiness Suite login (jtflogin) as SYSADMIN. 

2. Navigate User Management Tab > Users > Create User.

3. Fill in the details.

4. Select the user type as Business User.

CSI_SPLIT_
QUANTITY_UPDATE

Update permission for the Split Quantity page Y Y

CSI_SPLIT_
QUANTITY_VIEW

View permission for the Split Quantity page Y Y

CSI_SYS_CFG_VIEW Viewing Systems configurations. Y Y

CSI_SYS_DTL_
UPDATE

Update permission for the CSI System Detail page Y Y

CSI_SYS_DTL_VIEW View permission for the CSI System Detail page Y Y

CSI_TABLE_PERZ_
UPDATE

Update permission for the Table Personalized page Y N

CSI_TABLE_PERZ_
VIEW

View permission for the Table Personalized page Y N

CSI_TRANSACTION_
DETAIL_UPDATE

Update permission for the Transaction Detail page Y Y

CSI_TRANSACTION_
DETAIL_VIEW

View permission for the Transaction Detail page Y Y

CSI_TRANSACTION_
INSTANCE_UPDATE

Update permission for the Transaction Instance page Y Y

CSI_TRANSACTION_
INSTANCE_VIEW

View permission for the Transaction Instance page Y Y

CSI_TRANSFER_
OWNER_UPDATE

Update permission for the Transfer Owner page Y N

CSI_TRANSFER_
OWNER_VIEW

View permission for the Transfer Owner page Y N

Table 2–13 Permissions Supported by Install Base

Name Description Agent Customer
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5. Select that you already have a company, and select one of the companies listed 
(preferably Business World).

6. Click Submit. Now you are back on the Users page.

Approve and Assign Accounts

7. Select the Pending Approvals link.

8. Click on the user you just created.

9. Click Assign accounts, and select some or all of the accounts listed for the user 
and click Submit.

10. Optionally, click Approve on the Pending approvals page, enter comments, and 
click Submit.

Assign Role

11. Search for the user you just approved, and click on the user name.

12. Click Roles.

13. Move the role CSI_END_USER from the LHS List box to the right hand side 
using the single arrow button.

14. Click Submit to assign the role to the user

Assign Responsibility

15. Login to Forms, and switch to SYSADMIN responsibility

16. Select Security > User in the navigator.

17. Enter the user name (csiuser) and password 

18. Add the responsibility, Oracle Installed Base Customer, and any other 
responsibility that you might need for this user.

19. Note the Responsibility ID of the above from this line itself.

Set up Default Responsibility and Application ID.

20. In the navigator, Profiles > System Query JTF% for user name specified above.

21. Set the User profile value for the following:

JTF_DEFAULT_APPLICATION_ID to 542

JTF_DEFAULT_RESPONSIBILITY to the responsibility ID that you obtained 
above

22. Quit the forms window.
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23. Log in to the Oracle eBusiness Suite login (jtflogin) with the user name and 
password, and everything should be set. 

The accounts that you assigned in step 9 should be what will show up as the list 
of accounts associated with this user in the customer UI. It may be a subset 
because JTF shows all accounts regardless of active/inactive status whereas the 
Install Base window shows only the active accounts that are associated with this 
user.

2.5.23 Create Agent Users
Use this procedure to create an agent user for an internal user with the CSI_
NORMAL_USER role and the responsibility of Oracle Install Base user.3.

Steps

1. Login to jtflogin as SYSADMIN.

2. Use Management tab > Users > Create user. Fill in the details.

3. Select the user type as Individual User.

4. Click Submit. Now you are back on the user page.

5. Search for the user you just created, and click on the user name.

6. Click Roles.

7. Using the single arrow button, move CSI_NORMAL_USER from the list box to 
the right hand side.

8. Click Submit to assign the role to the user.

9. Login to Forms, and select the SYADMIN responsibility.

10. Select Security > User in the navigator.

11. Enter the user name (as in Step 1) and password. 

12. Add the responsibility Oracle Installed Base User and any other responsibility 
such as Oracle Installed Base Administrator to the user.

13. Please note the responsibility ID from the Oracle Installed Base User line itself.

14. Navigate to Profiles > System. Query JFT% for the user name specified earlier.

15. Set the user profile values for the following:

■ JTF_DEFAULT_APPLICAION_ID to 542

■ JTF_DEFAULT_RESPONSIBILITY to the responsibility ID from step 13
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16. Quit the Forms window.

In addition, you can define customized roles to have specific permissions to fit 
specific needs. Use this procedure to create a role.

Steps

1. Login as System Administrator on the HTML login.

2. Click the Settings tab. 

3. Click Create.

4. Provide a role name and description. This creates a role without any 
permission.

5. Query the role and click the role. The Role Mapping page appears, where 83 
predefined permissions are provided.

6. Using the transfer buttons, select the desired permissions. After you finish, click 
Update.

Alternatively, you can copy the permissions from either CSI_NORMAL_USER 
or CSI_END_USER and take out the unwanted permissions.

7. After you finish Role definition, restart the Apache server to see the updates. 
Now you can use this role to create new users. 

8. Assign the responsibility of Oracle Install Base Customer for customer users. 
Assign Oracle Install Base User for internal agent users.

2.5.24 Schedule the Expire End Dated Instances Program
This program goes through the end dates set up for instances to be expired. If the 
end date is past due, then the instances are set to expire. Schedule this program to 
run at least once a day. To schedule the program:

Steps

1. Login as Oracle Installed Base Admin in the forms mode.

The Navigator window appears.

2. Chose Others > Requests.

The Submit a New Request window appears.

3. Select Single Request, and click OK.

The Installed Base Requests window appears.
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4. From the Name LOV, select Expire End Dated Instances.

5. Click OK.

6. In the At these Times region, click Schedule.

The Schedule window appears.

7. Select the desired running schedule.

8. Click OK.

The Installed Base Requests window appears.

9. Click Submit.

2.5.25 Schedule the Initiate Mass Edit Program
This program polls the submitted mass edit sessions and calls the Process Mass Edit 
program to process eligible sessions. In order to process mass edit transactions, run 
the Initiate Mass Edit concurrent program or schedule it to run at a regular 
intervals. Oracle recommends that you schedule it to run at least once a day. To 
schedule the program:

Steps

1. Login as Oracle Installed Base Admin in the forms mode.

The Navigator window appears.

2. Chose Others > Requests.

The Submit a New Request window appears.

3. Select Single Request, and click OK.

The Installed Base Requests window appears.

4. From the Name LOV, select Initiate Mass Edit.

5. Click OK.

6. In the At these Times region, click Schedule.

The Schedule window appears.

7. Select the desired running schedule.

8. Click OK.

The Installed Base Requests window appears.
2-50 Oracle Install Base Implementation Guide



Setup Steps within Oracle Install Base
9. Click Submit.

2.5.26 Schedule the Process Mass Edit Program
This is the program that is called automatically to process the mass edit sessions. 
Schedule it to run at a regular interval to pick up mass edit sessions due to be 
processed. To schedule the program:

Steps

1. Login as Oracle Installed Base Admin in the forms mode.

The Navigator window appears.

2. Chose Others > Requests.

The Submit a New Request window appears.

3. Select Single Request, and click OK.

The Installed Base Requests window appears.

4. From the Name LOV, select Process Mass Edit Transaction.

5. Click OK.

6. In the At these Times region, click Schedule.

The Schedule window appears.

7. Select the desired running schedule.

8. Click OK.

The Installed Base Requests window appears.

9. Click Submit.

2.5.27 Schedule the Process Old Order Lines-Fulfillable Only Program
This program processes the old fulfillable order lines migrated from previous 
versions of Install Base. Run it once or twice a day for the month after you migrate. 
To schedule the program:

Steps

1. Login as Oracle Installed Base Admin in the forms mode.

The Navigator window appears.

2. Chose Others > Requests.
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The Submit a New Request window appears.

3. Select Single Request, and click OK.

The Installed Base Requests window appears.

4. From the Name LOV, select Process Old Order Lines-Fulfillable Only.

5. Click OK.

6. In the At these Times region, click Schedule.

The Schedule window appears.

7. Select the desired running schedule.

8. Click OK.

The Installed Base Requests window appears.

9. Click Submit.

2.5.28 Schedule the Resubmit Interface Process
This program processes the transactions in the Error processing table. It can be set 
up to process selected lines or all lines in the table. This program can be called to 
run by user request or can set up to run at a regular interval. To schedule the 
program:

Steps

1. Login as Oracle Installed Base Admin in the forms mode.

The Navigator window appears.

2. Chose Others > Requests.

The Submit a New Request window appears.

3. Select Single Request, and click OK.

The Installed Base Requests window appears.

4. From the Name LOV, select Resubmit Interface Process.

5. Click OK.

6. In the At these Times region, click Schedule.

The Schedule window appears.

7. Select the desired running schedule.
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8. Click OK.

The Installed Base Requests window appears.

9. Click Submit.

2.5.29 Schedule the Resubmit Waiting Transactions Program
This program processes the transactions that are set as waiting status in the Install 
Base update process. The program can be scheduled to run at a regular interval. To 
schedule the program:

Steps

1. Login as Oracle Installed Base Admin in the forms mode.

The Navigator window appears.

2. Chose Others > Requests.

The Submit a New Request window appears.

3. Select Single Request, and click OK.

The Installed Base Requests window appears.

4. From the Name LOV, select Resubmit Waiting Transactions.

5. Click OK.

6. In the At these Times region, click Schedule.

The Schedule window appears.

7. Select the desired running schedule.

8. Click OK.

The Installed Base Requests window appears.

9. Click Submit.

2.5.30 Final Synchronize On-Hand Balance between Inventory and Install Base
To maintain life-cycle tracking for all items that are to be tracked in Install Base, it 
maintains a mirror image of what is in Inventory. For new implementations of 
Install Base, all on-hand quantities of the Install Base trackable items were issued 
out of Inventory in Step 1 of the checklist. Now you must receive them back into 
Inventory. You must ensure that the Service Fulfillment Manager queue is up and 
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running before attempting this step. Oracle suggests that you use the miscellaneous 
receipt transaction in Inventory to do this step.

Refer to the steps in Oracle Service Fulfillment Manager Concepts and Procedures to 
start and make sure that the Service Fulfillment Manager queue is up and running.
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Implementation and Setup for Upgrade

Users

This chapter provides implementation and setup information for users who have an 
earlier version of Oracle Install Base and are upgrading to this version. Because you 
are an upgrade user, the application automatically updates much of your current 
setup. Therefore you are required to consider only a subset of the setup steps 
required for a new user.

This chapter covers the following topics:

■ Product Dependencies and Requirements

■ Setup Checklist for Upgrade Users

3.1 Product Dependencies and Requirements
The following modules must be installed and set up for Install Base to work. Refer 
to the appropriate guides to install and set up these modules:

■ Oracle Inventory

■ Oracle Enterprise Install Base

■ Oracle Service Fulfillment Manager

■ Oracle Order Management

■ Oracle Purchasing (Optional)

■ Oracle Accounts Receivable

■ Oracle Work in Process (Optional)

■ Oracle Bills of Material
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3.2 Setup Checklist for Upgrade Users
This following table provides a checklist of setup steps for upgrade users of Oracle 
Install Base. The entries for section reference in the table direct you to Chapter 2 for 
detailed step descriptions.

Table 3–1 Setup Checklist for Upgrade Users of Oracle Install Base

Step
Number Title

Required or
Optional Seeded? Extensible?

Section
Reference

1. Set Up Inventory Serial 
Control at the Master 
Level 

Required NA NA Section 2.3.2

2. Set Up Vendors Optional N N Section 2.3.5

3. Set Up Employees Optional N N Section 2.3.6

4. Confirm the Setup of 
Oracle Service Fulfillment 
Manager Event Queue

Required N N Section 2.3.9

5. Set Up the Action Menu in 
Order Management

Required N N Section 2.3.10

6. Set Up the Order 
Management Workflow

Required N N Section 2.3.11

7. Run the License Manager 
Program

Required N N Section 2.4.1

8. Verify the Setup of Four 
Profile Options for 
Enterprise Install Base

Required N N Section 2.4.2

9. Verify Location IDs in HZ_
LOCATIONS

Required Y N Section 2.4.3

10. Verify Codes for Asset 
Update Statuses

Optional Y N Section 2.4.4

11. Set Up Codes for 
Party-Account and 
Party-Contact Relationship 
Types

Required Y Y Section 2.5.2

12. Verify Codes for Instance 
Relationship Types

Required Y N Section 2.5.3
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13. Verify Extended 
Attribute-Level Codes

Required Y N Section 2.5.4

14. Set Up Extended Attribute 
Pools

Optional N N Section 2.5.5

15. Set Up Extended Attribute 
Classifications

Optional N N Section 2.5.6

16. Set Up Extended 
Attributes 

Optional N Y Section 2.5.7

17. Verify Accounting 
Classification Codes

Required Y N Section 2.5.8

18. Verify Codes for Instance 
Location Sources

Required Y N Section 2.5.10

19. Verify Party Sources Required Y N Section 2.5.11

20. Set Up Codes for 
Instance-Organization 
Unit Relationship Types

Required Y Y Section 2.5.12

21. Set Up the Transaction 
Subtypes LOV from 
non-Service Processes

Required Y N Section 2.5.19

22. Verify Transaction Error 
Source Types

Required Y N Section 2.5.21

23. Create Business Users Required N N Section 2.5.22

24. Create Agent Users Required N N Section 2.5.23

25. Schedule the Expire End 
Dated Instances Program

Required N N Section 2.5.24

26. Schedule the Initiate Mass 
Edit Program

Required N N Section 2.5.25

27. Schedule the Process Mass 
Edit Program

Required N N Section 2.5.26

Table 3–1 Setup Checklist for Upgrade Users of Oracle Install Base

Step
Number Title

Required or
Optional Seeded? Extensible?

Section
Reference
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28. Schedule the Process Old 
Order Lines-Fulfillable 
Only Program

Required N N Section 2.5.27

29.  Schedule the Resubmit 
Interface Process

Required N N Section 2.5.28

30. Schedule the Resubmit 
Waiting Transactions 
Program

Required N N Section 2.5.29

Table 3–1 Setup Checklist for Upgrade Users of Oracle Install Base

Step
Number Title

Required or
Optional Seeded? Extensible?

Section
Reference
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Oracle Install Base System Profile Options

and Debug Information

4.1 Oracle Install Base System Profile Options
Table 4–1 describes the profile options for Oracle Install Base. These profile options 
are to be set at the site level.

Table 4–1 Profile Options for Oracle Install Base

Profile Option Name Comments

CSI Allow Install 
Parameter Update 

Set to Y after migration to allow a one-time update to Install 
Parameters. Then it is set to N.

CSI Auto-Generate System 
Name   

Auto-generate System Number at time of system creation (Y or 
N).

CSI Auto-split Instances 
During Instantiation 

Auto split instances with multiple quantity to 1 per instance at 
time of instance creation (Y or N).

CSI BOM Explosion Level Number of BOM levels to explode for creation of component-of 
configuration from BOM setup (1, 2, 3.). Note that BOM 
explosion stops at any level where child is at quantity > 1. 

CSI Cascade System 
Termination 

Cascade system termination to instances (Y or N).

CSI Contracts Enabled Enable Install Base integration with Service Contracts (Y or N).

CSI Counters Enabled Enable Install Base Integration with Counters (Y or N).

CSI Debug Level For Debug, set at 9 or 10 for Debug to start.

CSI Default Instance Status Default Instance Status at time of instance creation. Pick one 
status from the LOV.
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CSI Default Version Label Default version label at time of instance creation. Pick one from 
the LOV.

CSI Display HTML UI Option to use Install Base HTML for display (Internal). Used 
by other CRM applications to use Install Base HTML UI (Y or 
N).

CSI Enable SQL Trace For Debug (Y or N). Set to Y to start Debug.

CSI Explode BOM Enable BOM explosion for top assembly with Install Base 
trackable components at time of shipment/fulfillment (Y or N).

CSI Forms to SSWA 
Default Responsibility

Default user for applications to launch HTML from forms. 
Default Installed Base User or from the LOV.

CSI Instance Termination 
Status 

Default Termination Status. Pick one from the LOV.

CSI Log file Name The name of the log file for Debug.

CSI Log File Path For Debug (’utl-file-dir’ parameter in init.ora).

CSI OE Line Processing 
Delay 

Delay between OE line processing. Time between order line 
processing to allow for Install Base update completion to avoid 
record locking. Recommended delay: 60 seconds.

CSI Propagate System 
Changes 

Propagate system changes to instances (Y or N).

CSI Propagate Systems 
Changes - Window 
Display 

Condition of propagating system changes to products when 
Propagate System Changes is set to ’Y’:

■ Always Display: Change only when the system info 
matches the product information. 

■ Always Change: Do not display and always change. 

■ Never Change: Do not display and do not change: 

CSI Stop At Debug Errors Set to Y to start debug (Y or N).

CSI System name Update 
Allowed 

System name update allowed after system name creation (Y or 
N).

SERVICE Master 
Inventory Validation Org 

INV master Validation Org used at time of online instance 
creation. Pick from the LOV.

Table 4–1 Profile Options for Oracle Install Base

Profile Option Name Comments
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4.2 Setting the Debug Option
Oracle Install Base provides an option to write debug information in a log file. By 
default, the debug feature is turned off. To turn the debug option off, change the 
profile option CSI_DEBUG_LEVEL value to 0.

To turn the debug option on, perform the following steps:

Steps
1. Change the value of profile option CSI_DEBUG_LEVEL to either 9 or 10.

2. Specify the value of the profile option CSI_LOGFILE_PATH to be the path of 
the directory on the server side where the log file should be written. 

You must choose the log file path from the list of paths defined for the 
parameter utl_file_di in the init.ora file. Alternatively, you can run the sql 
statement SELECT value FROM v$parameter WHERE name = ’utl_
file_dir’.

3. Specify the value of profile option CSI_LOGFILE_NAME to be the name you 
want to give to the log file. 

The specified log file will be written in the CSI_LOGFILE_PATH directory on 
the server side, and all debug messages will be written to this file. Each message 
in the log file will have the session ID and username attached to it.

4. Use these settings as required:

■ CSI Stop At Debug Errors: Set to Y to start Debug. 

■ CSI Enable SQL Trace: Set to Y to start Trace.
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